OSSIM registration utilities
INTRODUCTION

OSSIM (Open Source Image Map) incorporates open-source classes and tools to perform automatic image to image registration.
The registration is obtained by matching image chips between a slave and a master image (reference), and optimizing the projection model used for the slave image. 

Most of the registration classes are part of a plugin named “registration”. It is part of the ossim_plugins CVS module.

The methods and tools have been developed by the CSIR in South Africa : the Satellite Application Centre (SAC) and the ICT4EO group, Meraka Institute have organized and funded the project.
INSTALLATION

Prerequisites

Software

You need a compiled version of OSSIM, including the plug-in for registration (full source code is available via anonymous CVS).

The plug-in for GDAL support is also recommended.
You need to know OSSIM’s basics (building overviews, mosaicking, comparing images, etc…)

Data

Input image

The optical image whose geometry needs to be corrected:
Either

· a native, remotely sensed image with sensor and platform metadata  that OSSIM can read (e.g.: SPOT5 level 1A DIMAP, Landsat 5 1G fast format rev.B, Landsat7 1G fast format rev.C, …)
or
· a geo-referenced image that has been system corrected, with an inaccurate positioning and terrain effects (e.g.: SPOT4 level2A GeoTIFF)
It can be multi-band, in any format that OSSIM or GDAL can handle.

You need to know a bound for the initial accuracy error.

Clouds and artefacts can be marginally present.

NO DATA parts (edges?) should be identified as such by using a single OSSIM NULL value, mentioned in an .omd file. By default, 0 means NULL in OSSIM images.

Reference image

A geo-coded, accurately positioned, ortho-rectified image covering the input image footprint (since the input image is ill positioned, account for it by buffering the footprint)

Very few artefacts or clouds

Preferably finer resolution than the input image
One band is sufficient for registration (grey level registration)

Comparable wavelength to one of the input bands.
That reference image might have been corrected for radiometric topography effects (illumination effects due to slope and sun elevation)
Check that the NODATA parts are properly designated

Note: That reference image can be generated by mosaicking multiple images. Imagelinker can be used for that preparation step. The radiometry in the mosaic doesn’t need to be seamless. Support for on the fly reference mosaicking will be added soon in the registration tools
Digital Elevation Model

Covering the input image footprint (+ position error buffer)
If possible, comparable resolution with the input image.

Installation Guide

1. If necessary convert your DEM to OSSIM supported DEM formats (at this time : SRTM and DTED). Tutorials to do it using OSSIM are available. Also build overviews using img2rr.
2. It is HIGHLY recommended to tile the reference image, and to build overviews to speed up the registration processes (not applicable to wavelet compressed imagery).

3. If possible, also optimize your input images (tile and build overviews). This is usually not possible for raw sensor datasets.

4. Add OSSIM bin directory (using its full path) to the PATH environment variable. Thus you will be able to easily use the command line executable tools.

Test the installation

Launch the GUI imagelinker
· The GUI window will open.

In the menu bar, go to File-> Preferences

· Two plug-ins should be mentioned for GDAL and the registration plugins, with the full paths to gdalplugin.dll and registrationplugin.dll
Close the plug-in window

Open an input image in imagelinker
· a window displaying the reference image will pop up. If you forgot to build overviews, you will be prompted to do so (then do it!)
Left-click anywhere in the image

· the location and altitude will be displayed at the bottom of the image (status bar)

Check that the longitude and latitude are approximately correct, and that the altitude seems fine.

· if the altitude is “nan” then the geoid grid is probably not loaded, check its path in the preference file

· if the altitude is around 10m, then the DEM might not be loaded (only the geoid)
Open the corresponding  reference image as well.

· A second window will open itself.

Check that its footprint encompasses the input image
Activate the swipe view (in the menu bar of one of the images) between both images to see how good the initial positioning is.

If you’ve been that far, then OSSIM is ready for ortho-rectification (see below)
ORTHORECTIFICATION

Ortho-rectification is composed of two steps:

· co-registration, to create tie points

· optimization, to get a better fit

Then you can optionally export the corrected image, to create a standalone ortho-rectified output file (optional).

Information needed

You need to know the following information:

· reference image ground pixel size

· initial accuracy error (upper bound) for your input image

· good estimate of input image ground pixel size

· max viewing angle (from nadir) for the input image
· maximum height difference in the DEM over the input image’s footprint

Preparation

Overviews

In order to get a fast access to data during the co-registration process, you will probably need to create reduced resolutions sets (or overviews) for the input and the reference datasets. This can be done using the command line executable img2rr, or directly with imagelinker (it will ask for creation of reduced resolution sets).
Displays and visual tests

To visualize the datasets and check the ortho-rectification, it is advised to create an imagelinker project that includes two windows: one for the reference image and one for the input image. You will then be able to swipe between them using the swipe menu. Don’t forget to save your imagelinker environment as a project to re-use it later, when the input image will be re-positioned using a better model.

You can also create histograms to have a better display (use the command line tool create_histo or imagelinker), but they won’t be used by the co-registration.

File types explained

Many files will be created using the image root name, but different extensions:

.ovr: overview (reduced resolutions sets) files (typically 30% of full uncompressed image size)

.his : histograms

.omd: metadata, like min/max/null values

.geom: geometry files, for projection models.  The projection defined here can be completely different from the native image projection

.xml: most probably a tie points file

.prj: imagelinker project file, defining the opened datasets and their processing chains
Co-registration

Co-registration is an image to image (master to slave) registration process, based on normalized cross correlation of image chips. Chips are centred on corner points detected in the master (reference) image.

Sometimes, when the input image is badly geocoded, co-registration and optimization must be carried out at different scales (first a first coarse registration to build a better model).

An executable is used to start the co-registration process. The process is rather slow at full resolution. (Expect 15 minutes for a 60Mb input image)

Usage

The syntax is obtained by correl –h :

G:\OSSIM_REDIST\bin>correl -h

Usage: correl [options] <master_im> <slave_im>

  -c                minimum correlation, >=-1 and <=1 (default

                    0.800000000000000)

  -d                corner density, >0 and <=1 (default 0.002000000000000)

  -e                absolute accuracy error, in pixels (default

                    15.000000000000000)

  -h                display Usage/Help

  -m                band index to use for master (default 0)

  -o                output file name for tie points (default tiepts.xml)

  -p                projection type: M (master) or S (slave) (default M)

  -r                scale ratio, >0 and <=1 (default 1.000000000000000)

  -s                band index to use for slave (default 0)

  -t                template radius, pixel >=1 (default 7)
Arguments: 

Master (reference) image and slave (input) image paths (absolute or relative).

Options:

Try to always define all the options

-m

-s:

define the bands you want to match (we only match grey levels here).

The indices start at 0 so 0 usually means band 1

-p: projection you will use for matching, and also scale to use 

normally you will expect the masters projection to be used (M)

-r:

for initial reduced scale matching only, when the input image is very far from the reference. (eg: Landsat 5 levels 4 or 5)

Usually you would us the following system for determination of scale and accuracy error:

1. Estimate the maximum absolute accuracy error (in meters) : ae

2. Convert it to pixel absolute error pae using the projection and scale defined by option –p (eg, if accuracy is 1.5 km, and you are using –p M, and your master is 50 meter per pixel, then pixel error is 30)

3. use the following scale ratio sr :
sr = 20 / pae.
notes: 
- never go above 1.0 (use 1 if above 1)
- if sr <= 0.5, then you will need to build overviews for the master image.

-c :

usually between 0.7 and 0.9. Use a low threshold if the master and slave images are very different (different view angle, different sun elevation, different wavelength)

0.85 is a good value when the same sensors and wavelength are used. (eg: Landsat input versus a Landsat reference)

-d:

this will influence the number of tie points

-use a small density when full resolution match (-r 1), typically 0.0002
-use a high density for a reduced scale match, up to 0.1 for r=0.05, so you can get more tie points.

-t: template radius, in pixels

You will use a value between 2 and 7. This is typically the scale of corner features you want to detect and match. Use a small kernel when doing a subsampled match.

-o: this will define the XML file for tie points

They can grow quite big for full resolution matching (20 megabytes)

Normalized Cross Correlation image chips

The template kernel will be a square of size 2 * tr + 1, taken from the reference image around a corner point.

The image chip taken from the input image will be of size 2*( trp + pae) + 1. The initial (bad) registration will be used to position the input image chip.
Execution description:

· a progress indicator is displayed (percentage), one for every processed tile.

· 2D statistics are given in the end, in image space :
displacement mean
displacement 2nd order moments (min variance, max variance and rotation angle)

Output:

- a tabulated text file, difftiepts.txt,  is created and holds image to image tie points.
- a XML tie points file is exported at the end of the process. It is composed of a header and tie points. Each tie point is made of a reference ground point (WGS84 longitude latitude and height above the geoid) and of its corresponding image position for the input image (unit: pixels).
Model Optimization

The optimization processes create a new projection model or updates an existing model so that there’s a good fit for tie points.

Usually, sensor physical models should be preferred, but they’re only available if the metadata enables their initialization (so far only SPOT5, Landsat 5and Landsat 7 are ready).

Here’s a table of currently supported models:

	Class Name (case sensitive!)
	Parameters
	Needs initial state
	Minimum number of tie points
	Need DEM
	Works fine

	ossimBilinearProjection
	 - none -
	NO
	4
	N
	Y

	ossimPolynomProjection
	Monoms list, eg:
1 x y x2 y2 xy z
	NO
	One per monom
	Y
	Y

	ossimSpot5Model
	.geom file of SPOT5 image file(imagery.tif)
	YES
	4
	Y
	Y

	ossimLandsatModel
	.geom file or landsat file
	YES
	4
	Y
	NO

	ossimRpcProjection
	- none -
	NO
	40
	Y
	NO


There are two tools for optimization: modopt and rejout. The first tool makes use of all provided tie points to optimize a model. The second tool is more adapted to automatic coregistration, and first selects inliers before optimizing.

Modopt

Modopt is easier to use than rejout, but should be used only when tie points have been thoroughly tested (eg: manually acquired tie points)

Usage

modopt [options] <GML_tiepoints_file>

Options:

  -d <model_definition>: default=”ossimPolynomProjection{1 x y x2 xy y2 x3 y3 xy2 x2y z xz yz}”

  -h  display Usage/Help

  -g <geom_file> : output geometry file, default=optim.geom
Note that the model given with –d should be put into quotes (because of spaces)

It si possible to use any model that can be initialized, not only the default projection model which was used to acquire tie points.

Execution

Polynomial and bilinear projections use Least mean squares for fitting, which is very fast.

Sensor models (SPOT, Landsat) use an iterative non-linear method (Levenberg Marquardt) for fitting which makes them slow. They need derivatives, and compute those using finite differences. Try not to use too many tie points (around 3000 is a good figure). Ground RMS values (meters) are displayed for each iteration.

Output

Optimized model geometric file (.geom)

Rejout
Rejout starts by selecting inliers, using a RANSAC selection.

To use RANSAC, we must provide a supposed ratio of inliers (to stop iterations) and a supposed accuracy for the model.

Usage

Usage: rejout [options] <GML_tiepoints_file>

Options:

  -a <inlier_accuracy> : pixels, default=1.000000000000000

  -d <model_definition> :default=ossimPolynomProjection{1 x y x2 xy y2 x3 y3 xy2 x2y z xz yz}

  -g <geom_file> : output geometry file, default=rejout.geom

  -h display Usage/Help

  -i <inlier_ratio> : default=0.600000000000000

  -o <tiept_file> : output inliers tie points path,

                    default=inliers.xml

For

Execution

For each RANSAC iteration, the percentage of fitted tie points will be displayed.

When that ratio gets higher than the provided inlier ratio, outliers are rejected, inliers are written to a new tie point file and the model is optimized using all the inliers (as in modopt).

The optimized geometry is then exported as a .geom file.

Output

Tie-points inliers (XML)

Optimized model geometric file (.geom)

Exporting ortho-rectified image
To export the ortho-rectified image, just copy the geometry model file (.geom) so that is has the same root as the image file.

Then open imagelinker and open the image. The optimized geometry will automatically be used.

Select a good resampling filter (sinc)

Zoom to full resolution
Select File->Save as… in the menu bar
Check that the mean resolution in meters is correctly indicated. If you’d like a different projection / pixel resolution just use the Edit->View menu.
In the Export(save) window, choose a file name

Choose the file format you want (use ERDAS HFA = .img for files larger than 4gb)

Choose export options (compression, histogram, reduced resolution sets)

Save the image
Multiscale co-registration

We’ve already explained that initially, when the expected absolute accuracy error was too important (say, more than 20 pixels), then you should do an initial gross registration to lower that absolute accuracy below 20 pixels.

Using “correl –r <ratio> ….”, you will obtain a small tie points file (between 50 and 500 tie points usually)

Then use a simple optimization run to create a better model, that you will associate to the image before going for the full-resolution coregistration (correl –r 1 …)
e.g:

correl -r 0.05 -d 0.1 -t 3 -e 900 -c 0.75 -o gross.xml ref.tif input.tif

The absolute error is 900 pixels, which in resized images makes 0.05 * 900 = 45 pixels

Then, you will typically use one of the following models with rejout:

· ossimBilinearProjection
· ossimPolynomProjection{ 1 x y } (affine projection)

The required accuracy can be deduced from the resize factor in correl (-r) : ac = 1.0 / rf
e.g.:

rejout -d "ossimPolynomProjection{1 x y}" -i 0.5 -a 20 -g input.geom gross.xml
Now, we have a geometry file input.geom associated to the input file, so we can start a full resolution co-registration:

correl -r 1.0 -d 0.0002 -t 6 -e 22 -c 0.85 -o fine.xml ref.tif input.tif

ANNEXES
Annex A: Supported image file formats

Directly in OSSIM 

ADRG

CCF

CIB

DOQQ

DTED

ENVI

ERS

GeoTIFF

Ikonos

JPEG

Landsat FastFormat rev C (Landsat 7)

Landsat FastFormat rev B (Landsat 5)

NITF

QuickBird

RAW (general handler, BIL, BSQ, BIP)

RPF

SPOT5 DIMAP

SRTM

TIFF

USGS DEM

VPF

Through GDAL with the GDAL plug-ins.
You can see the complete list in imagelinker, when you click on the loaded GDAL plugins. 
Here’s an example list from my own GDAL 1.3.1.

“+” means that you can create a new file (export)

VRT (rw+): Virtual Raster

GTiff (rw+): GeoTIFF

NITF (rw+): National Imagery Transmission Format

HFA (rw+): Erdas Imagine Images (.img)

SAR_CEOS (ro): CEOS SAR Image

CEOS (ro): CEOS Image

ELAS (rw+): ELAS

AIG (ro): Arc/Info Binary Grid

AAIGrid (rw): Arc/Info ASCII Grid

SDTS (ro): SDTS Raster

DTED (rw): DTED Elevation Raster

PNG (rw): Portable Network Graphics

JPEG (rw): JPEG JFIF

MEM (rw+): In Memory Raster

JDEM (ro): Japanese DEM (.mem)

GIF (rw): Graphics Interchange Format (.gif)

ESAT (ro): Envisat Image Format

BSB (ro): Maptech BSB Nautical Charts

XPM (rw): X11 PixMap Format

BMP (rw+): MS Windows Device Independent Bitmap

AirSAR (ro): AirSAR Polarimetric Image

RS2 (ro): RadarSat 2 XML Product

PCIDSK (rw+): PCIDSK Database File

PCRaster (rw): PCRaster Raster File

ILWIS (rw+): ILWIS Raster Map

RIK (ro): Swedish Grid RIK (.rik)

SGI (ro): SGI Image File Format 1.0

Leveller (ro): Leveller heightfield

HDF4 (ro): Hierarchical Data Format Release 4

HDF4Image (rw+): HDF4 Dataset

PNM (rw+): Portable Pixmap Format (netpbm)

DOQ1 (ro): USGS DOQ (Old Style)

DOQ2 (ro): USGS DOQ (New Style)

ENVI (rw+): ENVI .hdr Labelled

EHdr (rw+): ESRI .hdr Labelled

PAux (rw+): PCI .aux Labelled

MFF (rw+): Vexcel MFF Raster

MFF2 (rw+): Vexcel MFF2 (HKV) Raster

FujiBAS (ro): Fuji BAS Scanner Image

GSC (ro): GSC Geogrid

FAST (ro): EOSAT FAST Format

BT (rw+): VTP .bt (Binary Terrain) 1.3 Format

LAN (ro): Erdas .LAN/.GIS

CPG (ro): Convair PolGASP

IDA (rw+): Image Data and Analysis

NDF (ro): NLAPS Data Format

L1B (ro): NOAA Polar Orbiter Level 1b Data Set

FIT (rw): FIT Image

MrSID (ro): Multi-resolution Seamless Image Database (MrSID)

JP2MrSID (ro): MrSID JPEG2000

RMF (rw+): Raster Matrix Format

MSGN (ro): EUMETSAT Archive native (.nat)

USGSDEM (rw): USGS Optional ASCII DEM (and CDED)

GXF (ro): GeoSoft Grid Exchange Format

Annex B : typical parameters
“correl” notes
· remember to always build OSSIM overviews first for the input and reference datasets before running “correl”
· define bands for master (reference) and slave (input) starting at index 0. So Landsat band 5 in the slave (input) dataset will mean: -s 4
· before running a fine correlation, if a gross correlation has been used, copy/rename the generated geometry file so that it will be used with the input dataset.

· correl –h will give you the help, including a parameter list
· a good DEM should be used. A corrected SRTM 30 meter would be nice

“rejout” notes

· rejout uses a random process, with a very high chance of success (97 %) : if it fails, you should increase the accuracy threshold (-a), lower the inliers ratio (-i) and  retry 

· try not to use an inlier ratio below 50% (0.5), rather increase the  accuracy threshold so you can find more inliers

Landsat 5 (with polynomial fit)
Input Definition
	Dataset
	Input Image
	Reference Image

	Sensor / platform
	Landsat 5
	Landsat 5 or 7 

same area (same path and row)

	Condition
	original (bad) ephemeris
	Optional: topography corrected 

	processing level
	-system corrected (1G), level 4 or level 5
-smooth resampling kernel (CC, do not use nearest neighbour)
	- ortho-rectified
- smooth resampling kernel (CC, cubic convolution, do not use nearest neighbour)


	Format
	Fast Format rev B (header.dat)
	Any OSSIM format

	GSD
	Around 30 m
	Around 30m

	Band
	5 (or 4 or 3)
	Same as input

	Projection
	any
	any (preferably UTM)

	Initial Position Error
	20.000 m
	best possible




Correl gross correlation
	Rescale

-r
	Corner

density

-d 
	Projection

-p
	error  (pixels)

-e
	template radius (pix)
-t
	minimum correlation
-c

	0.04
	0.1
	M
	800
	3
	0.74


Expected results:

1. Minimum 500 tie points

Rejout gross model
	Model definition

-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimPolynomProjection{1 x y}"
	28
	0.55


Expected results:

1. success

2. maximum RMS : 25 pixels

Correl fine correlation

	Rescale


-r
	Corner

density

-d 
	Projection


-p
	error (pixels)

-e
	template radius (pix)
-t
	minimum correlation
-c

	1.0
	0.0002
	M
	29
	6
	0.85


Expected results:

1. Minimum 2000 tie points

Rejout fine model

	Model definition


-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimPolynomProjection{1 x y x2 y2 xy xy2 x2y x3 y3 z zx zy}"
	1.6
	0.75


Expected results:

1. success

2. maximum RMS : 0.7 pixels

Landsat 7 (with polynomial fit)

Input Definition
	Dataset
	Input Image
	Reference Image

	Sensor / platform
	Landsat 7
	Landsat 7 

same area (same path and row)

	Condition
	original ephemeris
	Optional: topography corrected 

	processing level
	-system corrected (1G), level 4 or level 5
-smooth resampling kernel (CC, do not use nearest neighbour)
	- ortho-rectified
- smooth resampling kernel (CC, cubic convolution, do not use nearest neighbour)



	Format
	Fast Format rev C (*.FST files)
	Any OSSIM format

	GSD
	15 m
	Around 15 m

	Band
	8
	8

	Projection
	any
	any (preferably UTM)

	Initial Position Error
	1000 m ?
	best possible




Correl gross correlation
	Rescale


-r
	Corner

density

-d 
	Projection


-p
	error  (pixels)


-e
	template radius (pix)
-t
	minimum correlation
-c

	0.1
	0.001
	M
	80
	3
	0.74


Expected results:

2. Minimum 300 tie points

Rejout gross model

	Model definition


-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimPolynomProjection{1 x y xy x2 y2 z}"
	10
	0.6


Expected results:

3. success

4. maximum RMS : 10 pixels

Correl fine correlation

	Rescale


-r
	Corner

density

-d 
	Projection


-p
	error (pixels)


-e
	template radius (pix)
-t
	minimum correlation
-c

	1.0
	0.0001
	M
	20
	6
	0.85


Expected results:

2. Minimum 2000 tie points

Rejout fine model

	Model definition


-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimPolynomProjection{1 x y x2 y2 xy xy2 x2y x3 y3 z zx zy}"
	1.6
	0.75


Expected results:

3. success

4. maximum RMS : 0.7 pixels

SPOT 5

Input Definition
	Dataset
	Input Image
	Reference Image

	Sensor / platform
	SPOT 5, HRG
	Any high-resolution sensor

	Condition
	original (bad) ephemeris
	Optional: topography corrected 

	processing level
	Raw geometry : level 1A
	- ortho-rectified
- smooth resampling kernel (CC, cubic convolution, do not use nearest neighbour)



	Format
	DIMAP with GeoTIFF image
	Any OSSIM format

	GSD
	5m
	5m or below

	Band
	Panchromatic
	Comparable wavelength

	Projection
	Any
	any (preferably UTM)

	Initial Position Error
	50 m RMS
	best possible




Correl : fine correlation

Note there is no need for a rough correlation

Let’s call rr = reference GSD / input GSD.

Note: 0 < rr <=1.0

[ …. ] means : formula …. is to be computed by the user

	Rescale


-r
	Corner

density

-d 
	Projection


-p
	error  (pixels)


-e
	template radius (pix)
-t
	minimum correlation
-c

	rr
	0.0002
	M
	[ 20 / rr ]
	6
	0.85


Expected results:

3. Minimum 2000 tie points

Rejout : fine model

Note : we’re using a sensor model for SPOT5

	Model definition


-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimSpot5Model{metadata.dim}"
	1.5
	0.65


Expected results:

1. success

2. maximum RMS : 0.7 pixels

SPOT 1-2-3-4 (with polynomial fit)

Input Definition
	Dataset
	Input Image
	Reference Image

	Sensor / platform
	SPOT 1-2-3-4
	Any medium-res / high-res sensor with better GSD

	Condition
	
	Optional: topography corrected 

	processing level
	- system corrected (level 2A)
-smooth resampling kernel (CC, do not use nearest neighbour)
	- ortho-rectified
- smooth resampling kernel (CC, cubic convolution, do not use nearest neighbour)



	Format
	Converted to tiled GeoTIFF
(CAP and DIMAP are not ready yet)
	Any OSSIM format

	GSD
	Around 10 m
	10 m or better

	Band
	Panchro (P or M)
	Comparable wavelength

	Projection
	any
	any (preferably UTM)

	Initial Position Error
	1500 m
	best possible




Correl gross correlation

Let’s call rr = reference GSD / input GSD.

Note: 0 < rr <=1.0

[ …. ] means : formula …. is to be computed by the user
	Rescale


-r
	Corner

density

-d 
	Projection


-p
	error  (pixels)


-e
	template radius (pix)
-t
	minimum correlation
-c

	[ 0.12 * rr ]
	0.002
	M
	[ 19 / rr ]
	3
	0.75


Expected results:

4. Minimum 400 tie points

Rejout gross model

	Model definition


-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimPolynomProjection{1 x y}"
	21
	0.55


Expected results:

5. success

6. maximum RMS : 23 pixels

Correl fine correlation

	Rescale


-r
	Corner

density

-d 
	Projection


-p
	error (pixels)


-e
	template radius (pix)
-t
	minimum correlation
-c

	[ rr ]
	0.0002
	M
	[ 22 / rr ]
	6
	0.85


Expected results:

3. Minimum 2000 tie points

Rejout fine model

	Model definition


-d
	Inliers accuracy

-a
	Inliers ratio

-i

	"ossimPolynomProjection{1 x y x2 y2 xy xy2 x2y x3 y3 z zx zy}"
	2.2
	0.75


Expected results:

5. success

6. maximum RMS : 0.7 pixels

